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• CHAPTER 1 •

AMAZING PHOTO EDITING

We are using Adobe 
Photoshop Elements 6.
Throughout this series, students will learn:

•To Make photos look their best

•To Do more with photos as we learn



About the toolbox

Use tools in the toolbox to select, 
edit, and view images; some tools 
let you paint, draw, and type. The 
toolbox appears on the left side of 
the Full Edit and Quick Fix 

workspaces. In the Full Edit 
workspace, you can move the 
toolbox by dragging the gripper bar 
at the top of the box. You must 
select a tool in the toolbox before 
you can use it. Once selected, the 
tool is highlighted in the toolbox, 

F u l l  E d i t  Wo r k s p a c e

Menu bar Contains 
menus for performing 
tasks. The menus are 
organized by topic. For 
example, the Enhance 
menu contains 
commands for applying 
adjustments to an 
image.

Workspace buttons 
Moves you between the 
Guided Edit, Quick Fix, 
and Full Edit  
workspaces. These 
buttons change 
according to the current 
workspace.

Toolbox Holds tools for 
editing images.

Options bar Provides 
options for the tool you 
select.

Project Bin Displays 
thumbnails of opened 
images, and lets you 
easily manage them.

Palettes Help you 
monitor and modify 
images.

Palette Bin Helps you 
organize the palettes in 
your work area.
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and optional settings for the tool appear in the 
options bar, which is located below the shortcuts 
bar at the top of the workspace. Some tools in 
the toolbox have additional tools beneath them. 
These are called nested tools. A small triangle 
at the lower right of the tool icon signals that 
there are nested tools. When you select a tool, 
any additional nested tools appear in the options 
bar.

Note: You cannot deselect a tool once you select 
a tool, it remains selected until you select a 
different tool. For example, if you’ve selected 
the Lasso tool, and you want to click your image 
without selecting anything, select the Hand tool.

You can view information about any tool in the 
toolbox by positioning the pointer over it. The 
name of the tool appears below the pointer, this 
is called the tool tip. You can click a link in 
some tool tips to see additional information 
about the tool.
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About foreground and background 
colors

You apply the foreground color when you paint 
with the Brush or Pencil tools, and when you fill 
selections with the Paint Bucket tool. The color 
you apply to the Background layer with the 
Eraser tool is called the background color . 
You can see and change the foreground and 
background colors in the two overlapping boxes 

at the bottom of the toolbox. The top box is the 
foreground color, and the bottom box is the 
background color. The foreground and 
background colors are also used together by the 
Gradient tool and some special effects filters.

You can change the foreground or background 
color in the toolbox by using the Eyedropper 
tool, the Color Swatches palette, or the Color 
Picker. About patterns

C o l o r  r e v i e w

1. Choose a color with the 
Eyedropper tool

2. The Eyedropper tool makes 
it easy to copy a color 
without having to select a 
swatch. It copies, or 
samples, the color of an 
area in your photo to set a 
new foreground or 
background color. You can 
sample from the active 
image, from another open 
image, or from your 
computer’s desktop.

3. Click the Lock 
Transparency icon              
at the top of the Layers 
palette to lock the 
transparent areas of the 
layer, so that no painting 
occurs in them. Click the 
icon again to unlock.

4. Note: For type and shape 
layers, transparency is 
locked by default and 
cannot be unlocked 
without first simplifying 
the layer.
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About Patterns

You can paint a pattern with the Pattern stamp tool or fill a 
selection or layer with a pattern that you choose from the 
pattern libraries. Photoshop Elements has several patterns you 
can choose from.

To customize your images, or to make one-of-a-kind scrapbook 
pages, you can create your own patterns. You can save patterns 
that you create in a library, and then load libraries of patterns 
using the Preset Manager or the Pattern pop-up palette, which 
appears in the options bar of the Pattern Stamp tool and the 
Paint Bucket tool. Saving patterns allows you to easily use a 
pattern in multiple images.

Find Edges

The Find Edges filter identifies areas of the image with 
significant transitions and emphasizes edges. Like the Trace 
Contour filter, Find Edges outlines the edges of an image with 
dark lines against a white background and is useful for creating 
a border around an image.

Note: After using filters like Find Edges and Trace Contour 
that highlight edges, you can apply the Invert filter to outline 
the edges of a color image with colored lines or a grayscale 
image with white lines.

Adjustment Layer

A layer that lets you apply color and tonal adjustments to your 
image without permanently changing pixel values. Use 
adjustment layers to experiment with color and color tones. 
You can think of an adjustment layer as a veil through which 
the underlying layers are seen. 

Blending Mode

A feature that controls how pixels in an image are affected by a 
painting or editing tool. The blend color is applied to the base 
(original) color to produce a new color, the result color. When 
applied to layers, a blending mode determines how the pixels 
in a layer blend with pixels in layers beneath it.

More About Blending Modes

Blending modes control how pixels in an image are affected by 
a painting or editing tool. It’s helpful to think in terms of the 
following colors when visualizing a blending mode’s effect:

•The base color is the original color in the image.

•The blend color is the color applied by the painting or editing 
tool.

•The result color is the color resulting from the blend.
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You can choose any of the following blending modes from the 
Mode menu in the options bar:

Normal Edits or paints each pixel to make it the result color. 
This is the default mode. (Normal mode is called Threshold 
when you’re working with an image in bitmap or indexed-color 
mode.)

Dissolve Edits or paints each pixel to make it the result color. 
However, the result color is a random replacement of the pixels 
with the base color or the blend color, depending on the 
opacity at any pixel location. This mode works best with the 
brush tool and a large brush.

Darken Looks at the color information in each channel and 
selects the base or blend color—whichever is darker—as the 
result color. Pixels lighter than the blend color are replaced, 
and pixels darker than the blend color do not change.

Multiply Looks at the color information in each channel and 
multiplies the base color by the blend color. The result color is 
always a darker color. Multiplying any color by black produces 
black. Multiplying any color by white leaves the color 
unchanged. When you’re painting with a color other than black 
or white, successive strokes with a painting tool produce 
progressively darker colors. The effect is similar to drawing on 
the image with multiple felt-tipped pens.

Color Burn Looks at the color information in each channel 
and darkens the base color to reflect the blend color. Blending 
with white produces no change.

Linear Burn Looks at the color information in each channel 
and darkens the base color to reflect the blend color by 
decreasing the brightness. Blending with white produces no 
change.

Lighten Looks at the color information in each channel and 
selects the base or blend color—whichever is lighter—as the 
result color. Pixels darker than the blend color are replaced, 
and pixels lighter than the blend color do not change.

Screen Looks at each channel’s color information and 
multiplies the inverse of the blend and base colors. The result 
color is always a lighter color. Screening with black leaves the 
color unchanged. Screening with white produces white. The 
effect is similar to projecting multiple photographic slides on 
top of each other.

Color Dodge Looks at the color information in each channel 
and brightens the base color to reflect the blend color. 
Blending with black produces no change.

Soft Light Darkens or lightens the colors, depending on the 
blend color. The effect is similar to shining a diffused spotlight 
on the image. If the blend color is lighter than 50% gray, the 

  7  



image is lightened. If the blend color is darker than 50% gray, 
the image is darkened. Painting with pure black or white 
produces a distinctly darker or lighter area but does not result 
in pure black or white.

Hard Light Multiplies or screens the colors, depending on the 
blend color. The effect is similar to shining a harsh spotlight on 
the image. If the blend color is lighter than 50% gray, the 
image is lightened. This is useful for adding highlights to an 
image. If the blend color is darker than 50% gray, the image is 
darkened. This is useful for adding shadows to an image. 
Painting with pure black or white results in pure black or 
white.

Vivid Light Burns or dodges the colors by increasing or 
decreasing the contrast, depending on the blend color. If the 
blend color (light source) is lighter than 50% gray, the image is 
lightened by decreasing the contrast. If the blend color is 
darker than 50% gray, the image is darkened by increasing the 
contrast.

Linear Light Burns or dodges the colors by decreasing or 
increasing the brightness, depending on the blend color. If the 
blend color (light source) is lighter than 50% gray, the image is 
lightened by increasing the brightness. If the blend color is 
darker than 50% gray, the image is darkened by decreasing the 
brightness.

Pin Light Replaces the colors, depending on the underblend 
color. If the blend color (light source) is lighter than 50% gray, 
pixels darker than the blend color are replaced, and pixels 
lighter than the blend color do not change. If the blend color is 
darker than 50% gray, pixels lighter than the blend color are 
replaced, and pixels darker than the blend color do not change. 
This mode is useful for adding special effects to an image.

Hard Mix Reduces colors to white, black, red, green, blue, 
yellow, cyan, and magenta—depending on the base color and 
the blend color.

Difference Looks at the color information in each channel 
and subtracts either the blend color from the base color or the 
base color from the blend color, depending on which has the 
greater brightness value. Blending with white inverts the base 
color values; blending with black produces no change.

Exclusion Creates an effect similar to, but lower in contrast, 
than the Difference mode. Blending with white inverts the base 
color values. Blending with black produces no change.

Hue Creates a result color with the luminance and saturation 
of the base color and the hue of the blend color.

Saturation Creates a result color with the luminance and hue 
of the base color and the saturation of the blend color. Painting 
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with this mode in an area with zero saturation (a neutral gray 
area) causes no change.

Color Creates a result color with the luminance of the base 
color and the hue and saturation of the blend color. This 
preserves the gray levels in the image and is useful for coloring 
monochrome images and for tinting color images.

Linear Dodge (Add) Looks at the color information in each 
channel and brightens the base color to reflect the blend color 
by increasing the brightness. Blending with black produces no 
change.

Lighter Color Compares the total of all channel values for the 
blend and base color and displays the higher value color. Does 
not produce a third color, which can result from the Lighten 
blend, because it chooses the highest channel values from both 
the base and blend color to create the result color.

Overlay Multiplies or screens the colors, depending on the 
base color. Patterns or colors overlay the existing pixels while 
preserving the highlights and shadows of the base color. The 
base color is mixed with the blend color to reflect the lightness 
or darkness of the original color.
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Keys for painting and brushes: Result Shortcut

Switch to Eyedropper tool Any painting tool or shape tool + Option (except Impressionist Brush)

Select background color Eyedropper tool + Option-click

Set opacity, tolerance, or exposure for painting Any painting or editing tool + number keys (for example, 0 = 100%, 
1 = 10%, 4 and 5 in quick succession = 45%).

Cycle through blending modes Shift + + (plus) or - (minus)

Fill selection/layer with foreground or background color Option + Delete (Backspace), or Command + Delete (Backspace)

Display Fill dialog box Shift + Delete (Backspace)

Lock transparent pixels on/off / (forward slash)

Connect points with a straight line (draw a straight line) Any painting tool + Shift-click

Delete brush Option-click brush

Decrease/increase brush size [ or ]

Decrease/increase brush softness/hardness in 25% 
increments Shift + [ or ]

Select previous/next brush size , (comma) or . (period)

Select first/last brush Shift + , (comma) or . (period)

Display precise cross hair for brushes Caps Lock
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Simplify a layer

You simplify a smart object, frame layer, 
type layer, shape layer, solid color layer, 
gradient layer, or pattern fill layer (or a 
layer group imported from Photoshop) by 
converting it into an image layer. You 
need to simplify these layers before you 
can apply filters to them or edit them with 
the painting tools. However, you can no 
longer use the type- and shape-editing 
options on simplified layers.
Select a type layer, shape layer, fill layer, 
or a Photoshop layer group in the Layers 
palette.
Simplify the layer or imported layer 
group:
• If you selected a shape layer, click 

Simplify in the options bar.
• If you selected a type, shape, or fill 

layer, or a Photoshop layer group, 
choose Simplify Layer from either the 
Layer menu or the Layers palette More 
menu.



Apply a filter
Choose the area you want to apply the 
filter to:

To apply a filter to an entire layer, 
deselect any selected areas, and 
then select the layer in the Layers 
palette.

To apply a filter to a portion of a 
layer, use any selection tool to 
select an area.

Choose how to apply the filter:

To use the Filter gallery, choose 
Filter > Filter Gallery, select a 
category, and click the filter you 
want to apply.

To use the Effects palette, choose 
Window > Effects, select a 
category, and double-click the filter 
you want to apply.

To use the Filter menu, choose 
Filter, then choose a submenu 
followed by the filter you want to 
apply. If a filter name is followed 
by ellipses (…), a Filter Options 
dialog box appears.

If a dialog box appears, enter values or 
select options.

If available, select the Preview option to 
preview the filter in the document 
window. Depending on the filter and 
how you are applying it, use one of the 
following methods to preview the filter:

Use the + button or - button under 
the preview window to zoom in or 
zoom out.

Click the zoom bar (where the 
zoom percentage appears) to 
choose a zoom percentage.

Click-drag within the preview 
window to center a specific area of 
the image in the window. 

Click the Show/Hide button  at the 
top of the dialog box to hide the 
filter thumbnails. Hiding the 
thumbnails expands the preview 
area.

Click the eye icon  next to a filter to 
hide the effect in the preview 
image.

If the dialog box contains sliders, hold 
down Option while dragging a slider to 
see a real-time preview (real-time 
rendering).

Click in the image window to center a 
specific area of the image in the preview 

window. (This may not work with all 
preview windows.) Note: A blinking 
line beneath the preview size indicates 
that the preview is being rendered.

If you are using the Filter Gallery, or the 
filter opens in the Filter Gallery, do any 
of the following and click OK:

Click the New Effect Layer button  
at the bottom of the dialog box and 
choose an additional filter to apply. 
You can add multiple effect layers 
to apply multiple filters.

Rearrange applied filters by 
dragging a filter name to another 
position in the list of applied filters 
at the bottom of the dialog box. 
Rearranging the order of filters can 
dramatically change the way your 
image looks.

Remove applied filters by selecting 
the filter and clicking the Delete 
Effect Layer button .

If you are using a Filter command or the 
Effects palette, do one of the following 
and click OK:

Double-click the filter.

Drag the filter onto the image.
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Use the Background Eraser tool

The Background Eraser tool turns color pixels 
to transparent pixels so that you can easily 
remove an object from its background. With 
careful use, you can maintain the edges of the 
foreground object while eliminating 
background fringe pixels.

The tool pointer is a circle with a cross hair 
indicating the tool’s hotspot . As you drag the 
pointer, pixels within the circle and of a 
similar color value as the pixel under the 
hotspot are erased. If the circle overlaps your 
foreground object, and it doesn’t contain 
pixels similar to the hotspot pixel, the 
foreground object won’t be erased.

U s e  T h e  E r a s e r

1. The Eraser tool changes pixels in the 
image as you drag through them. If 
you’re working in the Background 
layer or in a layer with locked 
transparency, erased pixels change 
to the background color; otherwise, 
erased pixels become transparent. 
Transparent pixels are indicated by 
the transparency grid.

2. Select the Eraser tool  from the 
toolbox.

3. Set options in the options bar as 
desired, and then drag through the 
area you want to erase. You can 
specify any of the following Eraser 
tool options:  
Brushes Sets the brush tip. Click the 
arrow next to the brush sample, 
choose a brush category from the 
Brushes pop‑up menu, and then 
select a brush thumbnail.  
Size Sets the size of the brush in 
pixels. Drag the Size pop‑up slider or 
enter a size in the text box.  
Mode Brush mode erases by using 
characteristics of the brush tool, so 
you can make soft-edged erasures. 
Pencil mode makes hard-edge 
erasures like a pencil. Block mode 
uses a hard-edged 16‑pixel square as 
an eraser.  
Opacity Defines the strength of the 
erasure. An opacity of 100% erases 
pixels to complete transparency on a 
layer and to the background color on 
the Background layer. A lower 
opacity erases pixels to partial 
transparency on a layer and paints 
partially with the background color 
on the Background layer. (If Block 
mode is selected in the options bar, 
the Opacity option isn’t available.)
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Use the Magic Eraser tool

The Magic Eraser tool changes all similar pixels when you drag 
within a photo. If you’re working in a layer with locked 
transparency, the pixels change to the background color; 
otherwise, the pixels are erased to transparency. You can 
choose to erase contiguous pixels only, or all similar pixels on 
the current layer.

Use the Magic Extractor

Use the Magic Extractor to make accurate selections based on 
the appearance of foreground and background areas that you 
specify. You can specify these areas by placing colored marks in 
the areas you want to select. After you mark the areas and close 
the dialog box, only the foreground area appears in the photo.

The Magic Extractor makes it easy to select people or objects so 
that you can superimpose them on other backgrounds. For 
example, you can remove yourself from a photo of you on your 
bicycle at home, and superimpose it on a photo of cyclists in 
the Tour de France. You can save the extracted image as a file 
that you can use again and again.

Use the Eraser tool

The Eraser tool changes pixels in the image as you drag 
through them. If you’re working in the Background layer or in 
a layer with locked transparency, erased pixels change to the 
background color; otherwise, erased pixels become 
transparent. Transparent pixels are indicated by the 
transparency grid.

Use the Quick Selection tool

The Quick Selection tool makes a selection based on color and 
texture similarity when you click or click-drag the area you 
want to select. The mark you make doesn’t need to be precise, 
because the Quick Selection tool automatically and intuitively 
creates a border.

Use the Magic Wand tool

The Magic Wand tool selects pixels within a similar color range 
with one click. You specify the color range, or tolerance, for the 
Magic Wand tool’s selection. Use the Magic Wand tool when 
you have an area of similar colors, like a blue sky.

Delete a selected area

If you delete a selection on a Background layer or a layer that 
uses the Lock Transparency option, the selected area is 
replaced with the background color or checkerboard 
background pattern.

 Do any of the following:

 • Choose Edit > Delete to remove the selection. (If you 
delete a selection by mistake, you can choose Edit > Undo to 
get it back.)

 • Press the Backspace or Delete key to remove the 
selection. 

 • Choose Edit > Cut to cut the selection to the 
Clipboard. You can then paste it elsewhere.
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The zoetrope was invented in 1834 in England by William Horner. He 
called it the 'Daedalum' ('the wheel of the devil’). It didn't become popular until 
the 1860s, when it was patented by makers in both England and America. The 
American developer, William F. Lincoln, named his toy the 'zoetrope', which 
means 'wheel of life'. The zoetrope worked on the same principles as the 
phenakistiscope, but the pictures were drawn on a strip which could be set 
around the bottom third of a metal drum, with the slits now cut in the upper 
section of the drum. The drum was mounted on a spindle so that it could be spun, 
and viewers looking through the slits would see the cartoon strip form a moving 
image. The faster the drum is spun, the smoother the image that is produced.

This information is used with permission from the Bill Douglas Centre.

HISTORY OF ZOETROPE

http://www.exeter.ac.uk/bdc/

http://www.exeter.ac.uk/bdc/
http://www.exeter.ac.uk/bdc/


In 1826, a man called Dr. John Ayrton 
Paris began selling the first animated 
toys in London. He called his toy a 
thaumatrope, which is Greek for 'wonder 
turner'.It consisted simply of a disc with 
two pieces of string attached to it. When 

the disc was spun between the strings, 
the images on the back and front 
blended together to form a single 
picture. Popular images included birds in 
cages, circus performers and the 
encounters between dogs and cats.

A P E  18

1. Persistence of vision, 
first noted in 1820 
by Peter Mark Roget, 
refers to the length of 
time the retina (the 
"screen" at the back 
of our eyes which is 
sensitive to light) 
retains an image. If 
we see a light flash 
every tenth of a 
second or less, we 
perceive it as 
continuous. The 
impression of each 
flash of light 
remains, or persists, 
in the retina for at 
least one-tenth of a 
second. Because of 
this persistence, we 
can't tell where one 
flash ends and the 
next begins. Instead, 
we perceive a 
continuous light.

2. See our APE18 to 
build your own 
Thaumatrope
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The next stop in the development of animation was the 
phenakistiscope (Greek for 'deceptive view'). It was 
invented in 1830 simultaneously by Joseph Plateau in 
Belgium and Simon Stampfer in Austria. This toy had a 
disc carrying a series of images set in a ring around the 
circumference, with small slits between the images. 
When a rod was placed through the Centre of the disc, 
and it was spun in front of a mirror, a person looking 
through the slits from the back of the disc would see a 
moving image reflected in the mirror. The images used 
could either be abstract patterns or performers such as 
jugglers or acrobats.

The zoetrope is one of several animation toys which 
were invented in the19th century, as people 
experimented with ways to make moving pictures. The 
zoetrope appeared first in England in 1834, then France 
in 1860 and finally the United States in 1867. The 
"Daedatelum" was invented by William George Horner 
in 1834 and renamed "Zoetrope" by French inventor, 
Pierre Desvignes. In "zoetrope" you might recognize the 
root word "zoo" from a Greek word meaning animal or 
life. "Trope" is also from Greek and refers to things that 
turn.
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If, when you spin the zoetrope, you look 
over the top of the drum at the drawings 
instead of looking through the slots all 
you will see is a blur. The illusion of 
motion is gone. The slots of the zoetrope 
simulate flashes of light, creating a 
strobe. Persistence of vision is a 
stroboscopic effect. The images you see 

must be interrupted by moments of 
darkness in order for the illusion to 
work.

The Phi phenomenon is a result of 
human instinct. Our brains strive to 
make meaning from what we perceive. 
When we see different images close 
together our brains quickly create a 

W h e e l  o f  L i fe

1.The zoetrope is 
the wheel of life. 
When you place 
a strip of 
drawings inside 
the zoetrope's 
drum, spin it 
and look 
through the 
slots, you will 
see the images 
come to life. Of 
course, they are 
not really alive. 
This illusion of 
motion depends 
on two things; 
persistence of 
vision and the 
phi phenomenon.
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relationship between them. The metamorphosis of an 
umbrella into a mushroom makes a certain kind of 
sense, even though this is not something you would ever 
see in the real world.

Movies are composed of shots of different characters 
and events taken from a variety of angles and distances 
edited together. A skilled editor can take advantage of 
the phi phenomenon to maximize the illusion of 
continuity so that you may not consciously notice the 
cuts. But you, as the viewer, are most responsible for 
continuity. You see the shots together, and your mind 
creates a world from them which seems to have its own 
space and time.

The zoetrope and other nineteenth century animation 
devices such as the flipbook, thaumatrope, 
praxinoscope and mutoscope were steps in the 
development of film and television. On the surface, 
modern media technologies look different from the 
optical toys of the 1800s, but they share common 
properties. The zoetrope has slots that create a 
stroboscopic effect. Movie projectors have a shutter that 
interrupts the light from the projector bulb as the film 

advances through the gate. The strobe of the projector 
shutter keeps the film from blurring. Video images are 
scanned onto your television by a beam which zig-zags 
across the screen from top to bottom twice for each 
frame. In between each frame is a little black, which you 
may see as a roll-bar when your television's vertical hold 
needs adjustment.

The zoetrope's speed is variable. The faster it turns, the 
smoother the motion appears. When the zoetrope slows 
down so that each image is seen for a tenth of a second 
or more, the illusion of movement begins to break down 
and the strobe is more obvious. Film projectors usually 
run at a rate of 24 frames, or pictures, per second. VCR 
and DVD players play and/or record at a rate of 30 
frames per second. But old silent movie projectors run 
at 16 or 18 frames per second. They are so slow they 
seem to flicker.

In 1867 an American, William Lincoln, patented 'The 
Zoetrope' - the first use of the word. It was 
manufactured in large quantities. Most 19th century 
zoetropes had thirteen slots. A strip with 12 images will 
produce a moving subject that appears to progress 
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forwards. A strip of 13 images (the same number as 
slots) gives a moving image the impression that it is 
stationary. As the figures are always moving when 
viewed, they appear rather fuzzy. 
Milton Bradley was granted a British patent in 1867. A 
popular model was produced in Britain by the London 
Stereoscopic Company. In addition to strips, some 
zoetropes had paper discs that fitted into the base, 
usually giving moving geometric figures. In many 
shapes and forms the zoetrope has survived as a toy to 
this day.

Both the zoetrope and phenakistiscope provided the 
break in the images by the black space between adjacent 
slits in the disc or drum. However, this design was 
adapted by Emile Reynaud in Paris in 1877 to form the 
praxinoscope. It used a drum, just as the zoetrope had, 
with the images drawn on a band placed around the 
inside of the cylinder. However, rather than having slits 
through which the images were viewed, the cartoon 
strip was reflected in a series of mirrors, mounted in a 
ring set halfway between the outer edge of the drum and 
the central axle (see the picture below). When the drum 
was spun, the viewer watched the progression of images 

in the mirrors. A candle set above the axle allowed the 
images to be seen more clearly.

Two years later, Reynaud developed the design to create 

the praxinoscope theatre. With the drum now set into a 
wooden box, the lid of the box carried a hole through 
which the viewer saw a background scene that set the 
images on the cartoon strip in context.

Thomas Alva Edison invented the phonograph in 1877, 
and it had quickly become the most popular home 
entertainment device of the century. It was to provide a 
visual accompaniment to the phonograph that Edison 
commissioned William Kennedy-Laurie Dickson, a 
young laboratory assistant, to invent a motion-picture 
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system in 1888. Dickson built upon the work of 
Muybridge and Marey, a fact that he readily 
acknowledged, but he was the first to combine the two 
final essentials of motion-picture camera and projection 

technology. These were a device to 
ensure the intermittent but regular 
motion of the film strip through the 
camera, and a regularly perforated 
celluloid film strip to ensure regular 
transport of the film. Dickson's 
Kinetograph camera of 1893 
photographed up to 50 feet of 
celluloid film, usually at the rate of 
about 40 frames per second. This 

fast speed was needed for technical reasons.

The test subject shown here is Fred Ott's Sneeze, 
copyrighted but not used commercially. Because Edison 
had originally conceived of motion pictures as an 
adjunct to his phonograph, he did not commission the 
invention of a projector to accompany the Kinetograph. 
Rather, he had Dickson design a peep-show viewing 
device called the Kinetoscope in which a continuous 47-
foot film loop ran on rollers between an electric lamp 

and a shutter for individual viewing. Starting in 1894, 
Kinetoscopes were marketed commercially through the 
firm of Raff and Gammon for $250 to $300 apiece, and 
the Edison Company established its own Kinetograph 
studio (a single-room building called the "Black Maria" 
that rotated on tracks to follow the sun) in West Orange, 
New Jersey.  
from ENCYCLOPEDIA BRITANNICA
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MAKE OUR OWN ZOETROPE
Interactive Our own Zoetrope.1 The speed of the spin makes animation

We used a jar top to hold our APE creation and a CD rack up-side-down to support it

Touch to 
activate



• CHAPTER 3 •

Make sure you have access to a printer that can handle 
U.S. legal size paper or larger. You will need scissors.

We have our cafeteria staff keep large jar tops for use 
as our spinners and do this project once a year when 
we have enough tops to go around.

If you use CD’s, you will need to use 11” X 17” paper. 

BUILDING A ZOETROPE



P r e p a r a t i o n

1. There is a simple 
mathematical formula for 
figuring the size of paper 
you will need.

2.  Take the diameter of 
your spinner and divide it 
by 2  (this is the radius).

3.  Now take the square of 
this number. 

4. Next, multiply the 
number squared by π 
(3.14).

5.  Round off to the nearest 
larger inch and that is 
your paper size.

6. So, our large jar top is 
4.22 inches, divided by 2 
equals 2.11.

7. We multiply 2.11  by 2.11 
and get 4.4521.

8. We then multiply 4.4521 
by π and get 13.979594, 
so we use 14” paper.
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• Section 1 •

Getting Everything ready

U.S. legal 
size paper



S e t - Up

1. You will need a series 
of still images that 
are either already 
digital or you will 
have to digitize them. 
The less in each 
image, the better the 
Zoetrope will work 
later.

2. If you can picture the 
Betsy Ross American 
Flag and the circle of 
13 stars and a clock 
face with the hours 
marked inside the 
Flag stars, that is 
basically the process a 
Zoetrope works when 
spinning. 

3. The stars represent the 
viewing slats and the 
clock represents where 
the images will be 
placed.

4. Turn on your Rulers 
and Grid from the 
View Menu
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• Section 2 •

The Set-Up



S m a l l  S t e p s

1. So far, our project 
looks like the image 
on the right.

2. Next, we need to 
draw lines on each 
inch marking from 
the ruler and grid. 

3. Use the Line Tool 
and hold the shift 
key to draw a 
straight line. This 
will be where we cut 
our viewing slats a 
little later.

4. Remember, our paper 
is 8.5 inches tall, so 
we have to divide it 
because we only will 
need one piece of 
paper for the whole 
project if we plan 
correctly.
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• Section 3 •

Ready, Set, Zoe



M o r e  S t e p s

1. Still using the Line 
Tool, we will draw 
across at the two 
inch mark just so we 
do not use any area 
above the line at this 
point.

2. Next, every two inch 
mark, make a 
horizontal line so we 
separate areas for 
our animation 
images we will add 
soon.

3. By the time we have 
drawn our 
horizontal lines, we 
should have four 
work areas and an 
extra half-inch at 
the bottom.

4. The top work area is 
where our viewing 
slats are located.
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• Section 4 •

Zoe 2



A n i m a t i n g  S t i l l s

1. Each work area of 2 
inches by 14 inches 
can have a series of 
images. 

2. Generally, a 
Zoetrope has 12 
images and 13 slats 
for viewing.

3. Add each series of 
images to each work 
area so you use as 
much of your paper 
as possible before 
printing.

4. Once you complete 
this process, make 
sure your printer is 
set for larger paper.

5. Our printer needs a 
different paper tray 
for the 8.5” X 14” 
paper we are using.
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• Section 5 •

Adding Your Image Series



C u t  o n  t h e  l i n e s

1. Each work area 
becomes it’s own 
project piece as you 
cut along the 
horizontal lines we 
drew earlier.

2. Each set of images 
becomes an 
animation, so each 
work area with 
images is a separate 
project. This means 
more than one 
student can 
contribute  a series 
of images to one 
printing of the 
Zoetrope.

3. Use your scissors to 
cut out each series.

4. Fold the viewing slat 
piece before cutting 
so it is re-enforced 
by doubling up the 
paper.
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• Section 6 •

Cutting and More

Cut here
Cut here
Cut here

Fold here



T o ge t h e r

1. Since we are using 
the jar top, we place 
the viewing slats 
into the jar top.

2. Inside the viewer, we 
place one of our 
image series and 
spin.

3. Some images need 
faster spins than 
others. The beauty of 
the Zoetrope, is you 
control the speed and 
the images.

4. This is animation 
as it was in the 19th 
century, so enjoy.

5. Some Zoetropes 
work well on a turn-
table so the 
spinning is more 
consistent. Be 
creative and 
experiment with 
different methods.
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• Section 7 •

Putting it Together
Movie 3.1 Working Zoetrope



JUST CHECKING IN
Interactive 

Just Checking.2 Your 
name should appear 

at the top

Learn how to build 
your own widgets 

and publications with 
the complete series

Interactive Just Checking.1 
3D Cube



MONEY SPIN LITE

Interactive Money Spin Lite.1 Trial version of our popular educational activity

Up to 6 players can compete for success in any version of Money Spin

Visit our website at: http://whitebagsoftware.com/

Direct link: http://itunes.apple.com/us/app/money-spin1v4/id437500745?mt=8

Use this 
sample 
puzzle 
review 

interactive 
to learn 
about 
other 

Amazing 
Photo 

Editing 
books. 

Just touch 
to begin.

There are 
many 

puzzles to 
explore 
various 

messages 
including 
our APE 

series and 
our ACT 

series 
along with 
other data

This is a widget 

m
ade from

 an App

http://whitebagsoftware.com
http://whitebagsoftware.com
figure:%23
figure:%23


HELP SUPPORT US
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Our software available in the iTunes Store provides 
the funds needed to produce both free and reduced 
priced Apps and publications.

By buying our products, you will help continue our 
publication of many educational and family fun 
activities.
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Our publications are educational books available on the iBookstore. The ACT series is 
all about advanced features used to create chroma key effects in Apple iMovie utilizing 
application features in Apple Keynote or Microsoft PowerPoint, Apple QuickTime 10, 

and Apple iMovie. They are available for your use..

Interactive 
Help Support Us.1 
The ACT series 
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Our publications are educational books available on the iBookstore. The APE series is all about 
advanced features used to create various image effects available with digital imaging software 

applications. Our educational books are for you to use.

Interactive 
Help Support Us.2 

The APE series
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Modes of Transportation

Foods We Eat

All About Me

All Around the House

Making Change

Our Growing a2z4u&me Series
Interactive 
Help Support Us.3 
Vocabulary help for all
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Interactive 
Help Support Us.4 
An iBuild Opportunity 
series
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